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2) Abstract

Smart GIS for Desktop© software is completely developed by Egyptian developer (Mohamed
Elshayal) and, it is independent of any commercial software package, and it has been registered in
2005 in the Office of intellectual property rights protection - (ITIDA), and it has been used in
several World Bank projects in Yemen and Egypt.

Smart GIS for Web & Mobile© software is one of the best GIS software’s which can convert
desktop (AutoCAD Maps ,and Raster Maps ,and Excel points Maps ,and GPS points Maps ,and
Total Station Maps ,and GIS Shape file Maps) into Web GIS & Mobile GIS GPS applications, and
it has been registered in 2015 in the Office of intellectual property rights protection - (ITIDA),and it
has been used in several World Bank projects in Yemen and Egypt.

3) Introduction

e A Geographic Information System (GIS) is a desktop computer program for storing, retrieving,
analyzing, and displaying cartographic data.

e Desktop GIS Software programming is impacted by various sciences, which are integral to the
GIS programming such as geographic, graphic, database, operating research, software
engineering, software programming and code enhancement.

e A Web & Mobile GIS GPS Application is an application which can be used in all devices and
all operating systems for viewing, tracking, analyzing, and data collections.

e Web & Mobile GIS GPS Application developing is impacted by various sciences such as
communication, Web Application developing, and Mobile Application developing.

4) Obijectives

Developing a GIS, GPS, Database, Map editor and Web and Mobile software with the following
features

¢ Independent of any commercial software package, or code library.
e With no support of any governmental Organization.

¢ Divided into separate modules (up to 60 main modules), and all of these modules can be
easily upgraded to be used in building Internet Web or Mobile GIS GPS application.

e Free for noncommercial use.
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5) Methodology

Smart GIS Software development process model is “water fall model” or software life cycle. The
fundamental development activities of Smart GIS software are divided among the following stages:-

A) Requirements analysis and definition stage

B)

Reading, writing, modifying shape files, and data base files.

Search and query attribute data base tables and spatial data and Transfer data according to
its spatial location.

Select features from attribute data tables, and drawings
Finding the shortest path between 2 points in any poly line network
Tracking and saving the GPS route.

Converting between Lon.& Lat. and 23 projection coordinates system such as (Airy,
Australian National , Bessel 1841 , Bessel 1841(Namibia) , Clarke 1866 , Clarke 1880 ,
Everest , Fischer 1960 ,Fischer 1968 , Fischer 1968 , Fischer 1968 , Fischer 1968 , Hough,
International , Krassovsky , Modified Airy , Modified Everest ,Modified Fischer 1960 ,
South American 1969 , WGS 60 , WGS66 , WGS-72 , WGS-84 )

Download satellite Images from Google, and download ASTER and SRTM Digital
Elevation Module (DEM).

Strong Edit features and vertexes tools, with snap, rotate, scale, divide, and combine, undo,
and redo functions i. Strong Edit Tables tools, with copy, cut, past, clear, fill past, fill series,
undo, redo, sort rows, select, and delete functions

Control the layer appearance such as view color, selection color, editing color, label,
networking settings; modify database field date structure, and thematic field colors.

Open and rectify (geo-reference) most of the raster images such as bitmap, jpeg, gif, tiff,
png files

Convert shape file to web and Mobile GIS Applications

Software design stage

C)

9 main menus, 30 toolbar buttons, and more than 60 main forms have been designed to
reflect the above-mentioned requirements and to give the user the full control of the
software and its functions. Each menu, and form are designed to work with one requirement
or function according to the integration and coherence of the functions.

Software implementation and testing stage

More than 60 main modules contain all formulas and calculations. Each module are written
individually and tested by itself. Each module is designed to work with one requirement or
function, according to the integration and coherence of the functions.
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D) Software integration stage

Combining the above-mentioned modules, menus, toolbar buttons, and forms in one
complete system, which achieves the above mentioned system requirements.

E) Operation and maintenances stage

The system has been used in several international projects as assistance GIS software in
parallel with other international well known GIS software.

The System is offered as free noncommercial use for more than 100,000 users to install it
and put it into practical use. Many errors have been discovered and corrected.

6) Discussion

A) 0. What is a Geographic Information System?

A. Geographic Information System (GIS) is a computer program for storing, retrieving,
analyzing, and displaying cartographic data.

Vector Spatial Location Data= X, Y, Z
Attribute Data Base = Data information tables

B) The Difference between Raster and Vector Maps

Maps in Geographic Information Systems are represented thematically. A standard
topographic map will show roads, rivers, contour elevations, vegetation, human settlement
patterns and other features on a single map sheet. In a GIS these features are categorized
separately and stored in different map themes or overlays. For example, roads will be stored
in a separate overlay. Likewise, rivers and streams will each be stored as a separate theme.
This way of organizing data in the GIS makes maps much more flexible to use since these
themes can be combined in any manner that is useful. The following illustration shows
conceptually how maps are stored as themes in a GIS.

Line

@ Polygon
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Each different theme is stored on a separate overlay. The overlays on the left represent a
vector based GIS, where the information is stored as a series of points, lines and polygons.
The overlays on the right represent a raster based GIS, where the information is stored as a
series of discrete units called cells.

C) The Relation between Vector Spatial Location and Attribute Data Base

e Each Spatial Layer is consist of many Spatial features

e Each Spatial Feature consist of many vertexes (X, Y, z)

e Each Spatial Layer is related to one Attribute Data Base Table

e Each Spatial Feature is related to one Attribute Data Base Record
e Each Record consist of many fields (up to 255)

D) GIS Shape File types 2D & 3D (Point — Polyline — Polygon)

Shp file contain spatial Location data of each feature Which are:-
o Type 2D & 3D (Point — Polyline — Polygon)
o Number of Parts
o Number of Vertexes
o X,Y, and Z of each vertex
e Dbf file contain Attribute Data
o Each Attribute Data table consist of many records
o Each record consist of many fields (up to 255)
e Shx file is a relation file between the Shp file and Dbf fie
e Point Layer consist of one vertex per Feature(x, y, z)
e Polyline Layer consist of many vertexes per Feature
e Polygon Layer consist of many vertexes per Feature and closed
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7) Coordinates Systems Functions

A) Lon and Lat Geographic Coordinate System

The geographic latitude (abbreviation: Lat., or phi) of a point on the Earth's surface is the angle
between the equatorial plane and a line that passes through that point

The North Pole is 90° N; the South Pole is 90° S. The 0° parallel of latitude is designated the
equator, the fundamental plane of all geographic coordinate systems. The equator divides the
globe into Northern and Southern Hemispheres.

The Longitude (abbreviation: Long., or lambda) of a point on the Earth's surface is the angle
east or west from a reference meridian to another meridian that passes through that point.

All meridians are halves of great ellipses (often improperly called great circles), which converge
at the north and south poles.

B) Universal Transverse Mercator Coordinate System UTM

The UTM system divides the surface of Earth between 80°S and 84°N latitude into 60 zones,
each 6° of longitude in width and centered over a meridian of longitude. Zone 1 is bounded by
longitude 180° to 174° W and is centered on the 177th West meridian. Zone numbering
increases in an easterly direction.

Each of the 60 longitude zones in the UTM system is based on a transverse Mercator projection,
which is capable of mapping a region of large north-south extent with a low amount of
distortion. By using narrow zones of 6° (up to 800 km) in width, and reducing the scale factor
along the central meridian by only 0.0004 to 0.9996 (a reduction of 1:2500), the amount of
distortion is held below 1 part in 1,000 inside each zone. Distortion of scale increases to 1.0010
at the outer zone boundaries along the equator.

C) Converting Coordinates Between Lon Lat and UTM

onvert Coordinates System Calculator —
C Coordi Sy Calcul X
Geographic Geographic UTH Spheraid
[ Degrees Minutes Seconds | [ Decimal Degrees | |Worlu:| Geodetic Systern 1984 [WGS 54 j

Lan |3n |5?'. |19.21 Lon |20.955336111 w |3n4391.anm?515
Lat |3n |4a |24_ae Lat |30.805311111 v |34n:3991_14?11555
Zone |36 [1-60] R

Hemizphere & N (5

Convert Corvvert ‘ Conwert

Converting Coordinates System Calculator
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D) Map Projection

Configure Mew Transverse Mercator Projection
D aturn Mame |Eg_l,lpt_Fl ed_Belt
| Sawve P File Remove |
Spheroid D ata
|Seleu:t Spheroid j

Spheroid Hame |H elmert_1905

Semi M ajor Auis 6378200

Semi Minar Axis |535581 3.16962739 ReCalc Minaor Axis |

Flattening |298.3 Relalz Flattening |
Datum Data

Central Merdian |3'|

Scale_Factaor |'|

False E asting |E15000

False Narthing |&10000

Latitude OF Origin 130
To WGE584 Transformations

130 1o 13 [ 0 [ 0
k. | Cancel |
Mote
Configure Mew Transverse Mercator Projection warks only with Transverse
Mercator projections - For more information kindly pleaze wisit ;-
hittp: # v, S patialR eference.org

Configuring new Projection System

Menu = Tools = Configure New Projection System

. Load Projection File

. Add

. Save Projection File

. Remove

. Semi Major Axis

. Semi Minor Axis

. Flattening value

) Central Meridian

. False Easting

. False Northing

. Latitude of Origin

. To WGS84 Transformation
. http://www.SpatialReference.org
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Predefined Spheroid

O 0O o o0 o o0 o 0 o o0 O o O O O O o0 o o0 o o o o

AA Airy 1930

AN Australian National

BR Bessel 1841 Ethiopia Indonesia Japan Korea
BN Bessel 1841 Nambia

CC Clarke 1866 (NAD 1927)

CD Clarke 1880

EB Everest Brunei & E. Malasia (Sabah & Sarawak)
EA Everest India 1830

EC Everest India 1956

EF Everest Pakistan

EE Everest W. Malasia and Singapore 1948

ED Everest W. Malasia 1969

RF Geodetic Reference System 1980 (NAD 1983)
HE Helmert 1906

HO Hough 1960

ID Indonesian 1974

IN International 1924

KA Krassovsky 1940

AM Modified Airy

FA Modified Fischer 1960 (South Asia)

SA South American 1969

WD World Geodetic System 1972 (WGS 72)
WE World Geodetic System 1984 (WGS 84)

Map Projection Definition

Defined kMap Projection

It

Coordinates Systen : | Eappt_Red_Eel ﬂ
Zohe ’35— [1-60]

Hemizphere fw M 5

Maote

Defined bap Projection will be uzed to Define bMap Coord

ki eazurning Projetiorn

inatesz Syztem

|t kdeters

Coordinates System | Equpt_Red Belt J
Zone £ (1-60]

Hemizphere {+ f_“

Mate

keazuning Projection will be uzed to calculate Length, area, Distance, and Scale

Ok Cancel

Apply
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8) Spatial Digitizing and Editing Functions

A) Building New Shape File Spatial and Data Structure

RE Smart GIS Map Editor & GPS Tracking 2019 : Cairo.arb

File Edit View

BE]

[~ Street

[ Railway

M Bridge_shp
I8 landmark shp
I building shp
O Jpavement shp
[ » NewPaint1.shp

First Alrican Arab
GIS GI'S 8¢

Layers Selection MetWork

Move Up
Move Down
Show Al
Hide All

Zoom to Layer

New Layer > Paint..

Load (Add) Layer... Ctrie A Palyline...

Save Layer CirisS Polygon

Save Layer As... MultiPoints..

Remove Layer Point + Measure...

Reload Layer Ctrl+R Palyline + Measure...

Set Layer Data Source... Polygon + Measure

Layer Properties... CtrisL L DT - s

Load Layer Properties... Foint + Measure = Z..

A — Palyline + Measure + 7.
Polygon + Measure + 7.

Rt L) MultiPoints + Measure + Z...

Remove Deleted Features -

Validate Layer boundaries
Import Structure from
Goto Layer in Google Earth
Rectify Image (2 points)
UnRectify Image

Auto Balance Image

Save world File

Suface  Tools  Help

o

o

Map Unit = Degrees 36 North
Lonar= =31.199414508
Lator'y = 30063016431
Soale  =1:2167

> Copight® Reserved for Smart GIS Company { Mohamed Elshayal | 2002 - 2013 hitp://unana. frezsmartgis blagspot.com/
55 Thark you for using Sraat GIS Map Editor, you can shaw your appreciation and support future dewelopment by donating!
5> Open Project Caimab > Version: 13140

>

Building New Spatial Shape File

Menu = Layers = New Layer = Select Layer type

Layers
Move Up
Mowve Down
Show All
Hide All

Zoom to Layer

MNew Layer

Load (Add) Layer...
Sawve Layer

Sawve Layer As...
Remowve Layer

Reload Layer

Set Layer Data Source...

Layer Properties...
Load Layer Properties...

Sawve Layer Properties...

Data Table...

Remowve Deleted Features
Validate Layer boundaries
Impert Structure from

Goto Layer in Google Earth

Rectify Image (2 points)
UnRectify Image
Auto Balance Image

Sawve world File

Ctrl+A
Ctrl+5

Ctrl+R

Ctrl+L

Ctrl+T
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B) Digitizing Spatial Shape File ( Feature — Part — VVertex )

RE Smart GIS Map Editor & GPS Tracking 2017 : Cairo.arb
P £l
File Edit Wiew Layers Selection NetWork Surface Tools Help

i X O 4§ 8 o =laalSalsl m e p

Finish Drawing
O McitBuilding shp Start Drawing Circle in Active Layer
[ 4 Streets.shp . Add New Vertexes in Editing Part

14 raitway.shp _% @ Add New Part In Editing Feature

CIMlBridge shp [T =

Ml iandmark shp B %

Full Extend

[ building.shp a —— -
L Jpavement.shp ] % . o
CC]GOVBND shp o @

CILIMARKZBND shp Zoom Previous m3
CIL_vLGBND.shp P e Zoom Next F4
[ = Mcit.shp o~ .
[ = meit2.shp ol D reshMap

[ ® NewPoint3.shp Center

A Road shp — Start Pan Mode Chrbe W
[ 9 Points.shp

[ NewPalygan1.shp E Map Scale >

[ = js test(2).shp [%0

Map Projection and Units..
Copy Map to Clipboard Curl+C

M Pumb.shp 3
[ track.shp o @ )
[ = hosp.shp [% \,j 5 ]
CIBYGE_138)New.jpg =l Dg O Q o S/

&)
First Alrican Arabian Egyptian
GIS GPS Softwarc

AN
&
Map Urit = Degrees 36 Narth >» Make New POINT Layer NewPaint5 shp
Lonor® = 31.199018551 5> Add Laper NewPaints.shp
Latory = 30.052846348 3> = Open Project has been canceled =
Scale  =1:2500 3> Open Project Caimarh > Version : 17.027

5> Save Project Caro.ab

Digitizing Spatial Shape file

Buttons = Add New Feature = Start Digitizing

Finish Drawing
Start Drawing Circle in Active Layer
Add Mew Vertexes in Editing Part

Add Mew Part In Editing Feature

Full Extend

Zoom In F1
Zoorm Out F2
Zoormn Previous F3
Zoom Mext F4
Refresh Map F5
Center

Start Pan Mode Ctrl+W
Map Scale »

Map Projection and Units...
Copy Map to Clipboard Ctrl+C
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C) Editing Shape File ( Feature — Part — Vertex )

R smartGIs Map Editor & GPS5 Tracking 2017 : Cairo.arb - x

File Edit Wiew Layers Selection NetWork Surface Tools Help
QO %O A V[ || o8 S E S ¥

I IMcitBuilding shp
[ Streets.shp x o @ - e o AN
Darawlway,shp ? L Undo Drawing Edit Ctr+Z
M Bridge shp B . 1
S ook ahp - Redo Drawing Edit ChrieY
W[ building.shp a 7 Insert Vertex
DDpavemem.shp jE Delete Vertex
DLJcovenD.she Delete Part
CILIMARKZBND shp i |
CICVLGBND shp — Delete Feature
[ = Mcit.shp «.—1 | Can Not Divide Polyline at Edges
O = mcit2 shp Combine Polyline
E,:, gzvﬁ:ga,ahp Edit Feature Data... Ctil+E
[ o Paints.shp Move Distance...
' NewPolygon1 shp E_

Move To X, Y.
[ = js test(2).shp o
CIMPumb.shp L Move Settings... Ctrl+M
[ track.shp Set Pivot Point

(H

[ = hosp.shp K Start Rotate-Scale

CIl#1 GE_138)New.
@ 138) 103 Rotate-Scale Menu... F8

Bring Part to Front

|
T

Send Part to Back

f Invert Part Direction
Add New Vertexes in Editing Part

First Alrican Arabian Egyptian
GIS GPS Softwarc

Add New Part In Editing Feature
Gote Feature in Google Earth >

Length

LonerX = 31.195398834 Stop Edit =
LalorY = 30.054548475
Properties

Scale  =1:2500
ave FIOECt LAl an

Map Urit - Degress 36 Horh ] o= “
3
3
3
*
¥

Editing Spatial Shape file

Buttons = Edit Feature = Click cursor on the Feature = Right Click

Edit
Undo Drawing Edit Ctrl+Z
Redo Drawing Edit Ctrl+Y

Insert Vertex
Delete Vertex
Delete Part
Delete Feature
Divide Feature
Combine Feature

Edit Feature Data... Ctrl+E

Mowve Distance...

Move To X, Y.

Move Settings... Ctrl+M
Set Pivot Point

Rotate-5cale

Rotate-Scale Menu... F8

Bring Part to Front

Send Part to Back

Inwert Part Direction

Add Mew Vertexes in Editing Part

Add Mew Part In Editing Feature

Goto Feature in Google Earth »
Length

Area

Stop Edit F&
Properties
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D) Move Settings

i I B T B B

Thiz Part

o+ Mowve Settings —

Press Ctrl While
Movwing or Rotating or Scaling
to apply movement on

Thiz Feature

All Selected Features in editing layer

All Features in editing laver

All Selected Features in all Vizible layers [Hone Image]

All Features in all Vizible layers [Mone Image]

Press Shift While Moving to Snap

Press Alt While Moving to Right Angle

Editing Spatial Shape file

Menu = Layers = Move Settings

Press Ctrl while moving or Rotating or Scaling to apply movement on

. This Vertex

. This Part

. This Feature

. All Selected Features in Editing Layer

. All Features in Editing Layer

. All Selected Features in All Visible Layers (None Image)
. All Features in All Visible Layers (None Images)

Press Shift while Moving to Snap or Press Alt while Moving to Right Angle

E) Map View

Full Extend

Zoom In

Zoom Out
Center

Pan Move
Start Pan Mode

Map Scale

Map Projection and Units...

Refresh Map

Copy Map to Clipboard

Menu 2 View

F1
F2

Crl+w

FS

Ctri+C
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F) Converting between Shape File types 2D & 3D (Point — Polyline — Polygon)

Convert Shape Type and Grouping — >
From Layer |Streets.shp ﬂ Corrvert
Laver Type  PolyLine
Creteria |.-i‘-.II Features j
Too Mew Laer |F:"-.Maps'x|:ain:||3 eovMewShapel. shi Browse |
Laver Type |F'|:uint j
[w Group By [w Sum Mumerical Figlds
Group by Field |y apE j

Mate :
Corvert ShapeType and Grouping is a ven pawerfull toal, So please uze it carefully.

Converting Shape Type and Grouping

Menu = Tools = Convert Shape Type and Grouping

. Select Destination Layer

. Select Criteria (All Feature or Inside Selected Features or Outside Selected Features)
. Select Output Shape File

. Select Output Shape File Type

. Select Group By or Not

. Select Summing Numerical Fields or Not

. Select Group By Field
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9) Layer Properties Functions

A) Layer Properties General Option

%! Streets.shp : Single Layer Prorperties

General

v Vizable Apply on Layers

* Always Show

- b

1| Color | Selection | Edit | Label | Fields | Metwork | Hyper Link | 3D View | VB Script | Source |

building. shp
- pavement. shp
Show When scale between GOVEMD.shp v
Min scale Max scale [~ Show Vertex
il 0
Wertex Width Hboooamonsosonosonasons
Ok Cancel Apply |

Layer Properties General Option

Menu = Layers = Layer Properties = General

. Select Visible or not

. Select on which Layers, your selection will be applied

. Select Show Vertex or Not

. Select Vertex Width

. Select Always show to view the layer all the time

. Select Show When Scale between Min Scale and Max Scale

B) Layer Properties Color Option

Streets.shp : Single Layer Prorperties — *
General Color Selection] Edit ] Label] Fields] MNetWork | Hyper Link] 3D View] VB Script] Source]
Dirawe Fore Color _ Drraw Mode Copy Pen -
Drravy Fill Color l:l Diraw Style Solid -
Thematic Field
Apply Color Ramp MAME hd Draw Width m
Femaove Add
Gl sl Gl ) -
Down Up :lL;L)?J:,ﬁ; Gl Draw Fill Style Solid -
Save Load sl ol b
Ok Cancel Apply |
Layer Properties Color Option
Menu - Layers - Layer Properties - Color

. Select Draw Fore Color and Draw Fill Color
. Select Draw Mode
. Select Draw Style
. Select Draw Width
. Select Draw Fill Style
. Select Thematic Field and add Values and select each Value Colors, Mode, Style
. Select Apply Color Ramp to change colors of all added values
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Unique Values

Unique Values
e g oo Sl -~
Y IR PRy g S
Sralaadl i Sl
JUC WY 4| RS B U
Sl T Sloe
e Ll Sl
Gl G Sl dore
ottt 3 0 il e
LT e
TIC-LE BTN PO
Ghes Gl w
< >

926 Features have been updated Unique in
Laver Streets. shp

Add | T erminate I

I.wl &l apn Ziplaes £ 5L Mew Malue |

Layer Properties Color Option: Add Thematic Value

Cancel I

Menu - Layers - Layer Properties = Color > Add

C) Layer Properties Selection Option

Color Ramps

Apply Color Ramp on all
Thematic Added Values

* Apply No Color Ramp:

Ok I Cancel I

Layer Properties Color Option : Apply Color Ramp on Added Value

Menu > Layers = Layer Properties = Color = Apply Color Ramp

Streets.shp : Single Layer Prorperties

| Edit | Label | Fields | NetWark | Hyper Link | 3D View | VB Seript| Source |

- X

.
I

Select Fore Color

Select Fill Color

|¥ Selectable (SnapTo)

ICopy Pen VI

Select Draw Mode

ISolid vl

Select Draw Style

Select Draw Width

ISolid Vl

Select Fill Style

ok |

Cancel

| Apply

Layer Properties Selection Option

Menu = Layers = Layer Properties = Selection

. Select Selection Fore Color

. Select Selection Fill Color

. Select Selection Mode

. Select Selection Style

. Select Selection Width

. Select Selection Fill Style

. Select Selectable ( Snap to ) or Not
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D) Layer Properties Edit Option

Streets.shp : Single Layer Prorperties — X
General | Color | Selection Edit lLabeI] Fields | NetWork | Hyper Link | 3D View | VB Script | Source |
Edit Fare Color Edit Draw Mode Copy Pen -
Edit Fill Color I:l Edit Draw Style Solid -
[¥ Editable ( Snap From ) Edit Draw width T
Edit Vertex Width T T Edit Fill Style Solid -
[Shap Area) Press Shift + Move to Snap
Ok Cancel Apply |

Layer Properties Edit Option

Menu = Layers = Layer Properties > Edit

E)

Select Edit Fore Color

Select Edit Fill Color

Select Edit Mode

Select Edit Style

Select Edit Width

Select Edit Fill Style

Select Editable ( Snap From ) or Not
Select Edit Vertex Width ( Snap Area)

Layer Properties Label Option

Streets.shp : Single Layer Prorperties —

Label Field Mame NAME -*
" Always Show Label AR e ’Ariali J

¢+ Show Label When scale between [~ Font Bold [~ Font Italic Fort Size |12

|

[~ Force Size to Fit Palyline length and Palygon width

Min scale tax scale Font Color

i |25000

Refere Font Size to
M this Map Scale 2500

X

General | Color | Selection | Edit  Label lFieIds] NetWork | Hyper Link | 3D View | VB Script | Source |

Ok Cancel Apply |

Layer Properties Label Option

Menu = Layers = Layer Properties > Label

Select Show Label or Not

Select Label Field Name

Select Label Font

Select Label Fore Color

Select Always show to view the layer all the time

Select Show When Scale between Min Scale and Max Scale
Select Refer Label Font Size to this Map Scale

Select Force Label Size to Fit Polyline length and polygon width
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F) Layer Properties Hyper Link Option

Streets.shp : Single Layer Prorperties

= Open URL in Internet E xplorer

" Open Using another Software [ please select |

- X

General | Color | Selection | Edit | Label | Fields | NetwWork Hyper Link | 3D View | VB Script| Source |

[v Identify Hyper Link Hyper Field Mame =

Browse

Ok Cancel Apply |

Layer Properties Hyperlink Option

Menu = Layers = Layer Properties > Label

. Select Identify Hyperlink or Not

. Select Hyperlink Field Name

. Select Open URL in Internet Explorer

. Select Open Using another Software (Please Select)

G) Layer Properties Source Option

Streets.shp : Single Layer Prorperties

File Source
F:\MapshCairoGeohStreets. shp

Shape Filz Type  PolyLine Shape File Size 2226
Top Extend
30.0716648102

Left Extend

21.1905193329

Bottom Extend
300209274292

Right Extend

31.2275810242

Ok Cancel Apply

Layer Properties Source Option

Menu = Layers = Layer Properties 2 Source
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10) Attribute Data Table Functions

A) Modifying Dbf File Data Structure

telernetry.shp : Single Layer Prorperties - n
General | Color| Selection | Edit | Label Fields lNethrk] Hyper Link | 3D View | VB Script | Source |

# Field Mame Type Length | Decimal Caption i‘
1 [NAME Character 50 0 o gl audd

2 |SOURCE_CAN Character 50 0 gl ade & Ll 2 a )

3 |KILOMETERS Murmeric 13 1 s a8 a8 sl

4 |DIRECTORAT Character 254 0 2 !

5 |ZOMNE_MAME Character 50 0 <ilatall

R ITYOIE (Charartar PRA n PR ﬂ

Modify Structure Down Up Delete | Insert | Append |
Ok Cancel Apply |
Layer Properties Fields Option
Menu = Layers - Layer Properties - Fields

. Press Append Button to add new field at end of fields list

. Press Insert Button to add new field above of the selected Field

. Press Delete Button to delete the selected field
) Press Up Button to move Selected Field Up
. Press Down Button to move Selected field Down
. In the Field Name Column, type a Unique Field Name
. In the Type Column, Select ( Character or Date or Logic or Numeric )
. In the length Column, Enter the field Length
. In the Decimal Count Column, Enter the number of Decimal digits
. In the Caption Column, Enter the field Description.
. Press Modify Structure Button to apply the Field Modification
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B) Editing Data Table

telemetry.shp : Date Table - X
File  Edit  View  Selection  VBScript Help
Undo Data Edit Ctrl+Z
Redo Data Edit Culev  nique values Laver  |elemetmsho =
Creteria |6l Features -
Select Features
UnSelect Festures Method  |Mew Selection -
Delete Features [~ Malch Case Scale [0
UnDelete Features |
Commvert UTF8 to Ascii ]
Convert Ascii to UTFB
Recorc ) | ‘ 5 ) ailaal) | PR S gl 2 pma JE TP PN Fy
; Edit Feature Data... Ctrl+E . — =
2 all L Ly cuilis 5 s o S
Browse HyberLink Ciri+B e 2 = s
2 il ) Lo e (oSl s )
Cut Ctrl+X
FEEn il s + i PRI
g Copy Ctrl+C Eui i et +
4 Past Ctrl+V i ) oy ulse
4 al) <) Loy s
z Fill Past i e -
6 Fill Series... adyal) ) e )
7 Clear Cells Shift+Del sl ) fas s i Jabud
8 Sort Rows Ascending ) Loy s Ayl pmall
9 Sort Rows Descending el sy o S e
10 % ga M ijm ) Ly Cipa M ija
1 e g cuap BN ) ER T Slea + i SRS A
12 [omvats [oue 20 PR i izt
13 st gt o 24| Juge e &l ull 358 [ e
M |ueleyis (g st Er T g
15 sy el el i . L
16 s _slal oy il

e o

5 4 =\

g ™

L TOGAM
W NG a9

Menu = Layers = Data Table

Edit
Undo Data Edit
Redo Data Edit

1 Select Features

Un5elect Features

Delete Features

UnDelete Features

Comnvert UTFS to Ascii
Convert Ascii to UTFS

Edit Feature Data...

Erowse HyberLink
Cut

Copy

Past

Fill Past
Fill Series...

Clear Cells

I Sort Rows Ascending

Sort Rows Descending

Ctrl+Z
Ctrl+Y

Ctrl+E
Ctrl+B

Ctrl+ X
Ctrl+C
Ctrl+V

Shift+Del

Editing Data Table
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C) Running VB script in Data Table Fields

Carl1User.shp : Single Layer Properties

Download Tables [ Points ar Users or Pathes | from GPS Tracking Google Map [Google Store’

Account= SmartG15 &DBazeMm= UserzList &ThiMm= U sMm=
EPowrd= &vear= &Month= &Day= &Hour=

WB Script Code [ to be executed in each record |

Edit

- bd

Apply & Run in all Becs. ‘

Fun Every 1 Minutes

PathLyr = GetLyrNumber("Car01PathLine_shp") - i Fields KEYID ~
IF Not { { GetVertexX(0) = GetVertexX(VertexesCount( Number gg&m
SelectFeature ; String FLILLNM
SelectFeature RecMo( ), PathLyr = Date TELENUM
Else = ED”."E’S'D” EMAILADDRS
UnSelectFeature . POSITION
UnSelectFeature RecMo( ), PathLyr { " GIS Funcs DIRECTORAT
End IF " GIS Subs CIRTYFE W
W £ >
< 3 Save | Load
ARB Prefi iz Heserved
Ok Cancel Apply |

Layer Properties VB Script Option

Menu = Layers = Layer Properties > VB Script

. Select Fields for Fields Name List

. Select Number for VB Number Functions List

. Select String for VB String Functions List

. Select Date for VB Date Functions List

. Select Conversion for VB Conversion Functions List
. Select Logic for VB Logic Functions List

. Select GIS Funcs for GIS Functions List

. Select GIS Subs for GIS Procedures List

. Press Apply & Run in All records

° Note that "ARB" Prefix is Reserved

Numbers Functions

o Abs()
o Atn()
e Cos()
e Exp()
o Fix()
o Int()

e Log()
e Sin()
e Sar()
e Tan()

String Functions
o Asc()
e Chr()
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e Format( )

e InStr( )

o LCase()

o Left()

e Len()

e LTrim()

o Mid()

e QBColor( )
o Replace( Text, Find , ReplaceWith , Start , Count )
e Right()

e RTrim( )

e Space( )

e StrConv( )
e String( )

e Trim()

e UCase( )

Date Functions
o Date( )
o DateAdd( )
e DateDiff( )
o DatePart( )

e Day()
e Month( )
o Now()
o Time( )
e Year()

Conversion Functions

e CBool( )
o CByte( )
e CCur()
o CDate( )
e CDbI()
e CDec( )
e Cint()

e Clng()
e CSng()
o CStr()

e CVar()

Logic Functions

o |F

e THEN

o Else

o ElselF

e EndIF

e Select Case
o (Case

e End Select
e For
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e To

o Next

e  While

e Wend

e Do

e Do While

e Loop While
e Loop Until

GIS Functions
e Angle(X1,Y1,X2,Y2,X3,Y3)
e AngleVertex( SegNol, SegNo2 , SegNo3, PartNo , RecNo , LayerNo )
e Area( RecNo, LayerNo)
e BOF( LayerNo)
e DecimalDegree(DD MM SS)
e Degrees(DD)
e Distance( X1,VY1,X2,Y2)
o DistanceVertex( SegNol , SegNo2 , PartNo , RecNo , LayerNo )
e EOF(LayerNo)
e  GetCntrX( RecNo, LayerNo)
e GetCntrY( RecNo, LayerNo)
o  GetFieldValue( FIdName , RecNo , LayerNo )
e  GetLyrNumber( LayerName )
o GetMaxM( RecNo , LayerNo )
o GetMaxX( RecNo, LayerNo)
e GetMaxY( RecNo, LayerNo)
e GetMaxZ( RecNo, LayerNo)
o GetMinM( RecNo , LayerNo )
o GetMinX( RecNo, LayerNo)
e GetMinY( RecNo, LayerNo)
e GetMinZ( RecNo, LayerNo)
o  GetVertexM( SegNo , PartNo , RecNo , LayerNo )
o  GetVertexX( SegNo, PartNo , RecNo , LayerNo )
e GetVertexY( SegNo , PartNo , RecNo , LayerNo)
o  GetVertexZ( SegNo , PartNo , RecNo , LayerNo )
e Inside( LayerNo, Start)
e Intersect( LayerNo , StartRecNo )
e IsDeleted( RecNo, LayerNo )
e IsSelected( RecNo , LayerNo)
e LayerName( LayerNo)
e Length( RecNo, LayerNo)
e Minutes(DD)
e PartsCount( RecNo ,LayerNo )
e RecordsCount( LayerNo )
e Seconds(DD)
o VertexesCount( PartNo , RecNo , LayerNo )
e RecNo( LayerNo)

GIS Subs
e AddRecord LayerNo
e AddVertex X,Y ,M, Z, PartNo, RecNo, LayerNo
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e DeleteFeature RecNo , LayerNo
e DeleteAllFeatures LayerNo

e DeleteVertex SegNo , PartNo , RecNo , LayerNo
o DeleteVertexX0Y0 RecNo , LayerNo

e DrawCircle CntX, CntY , Radius, PartNo , RecNo , LayerNo
o InsertVertex X,Y ,M, Z, SegNo, PartNo , RecNo , LayerNo

e MoveToMaxM m, RecNo , LayerNo
e MoveToMaxX x , RecNo , LayerNo
e MoveToMaxY y, RecNo, LayerNo
e MoveToMaxZ z, RecNo, LayerNo
e MoveToMinM m, RecNo , LayerNo
e MoveToMinX x, RecNo , LayerNo
e MoveToMinY y, RecNo, LayerNo

e MoveToMinZ z, RecNo, LayerNo

e MoveToVertexM m, SegNo , PartNo , RecNo , LayerNo
e MoveToVertexX x, SegNo , PartNo , RecNo , LayerNo
o MoveToVertexY y, SegNo , PartNo , RecNo , LayerNo
e MoveToVertexZ z, SegNo , PartNo , RecNo , LayerNo

[T

e MsgLine

e PutFieldValue FIdName , Value , RecNo , LayerNo

o RefreshLayer LayerNo

e RotateVertex PivotX , PivotY , Angle, SegNo , PartNo , RecNo , LayerNo

e SaveChanges LayerNo

e SelectFeature RecNo, LayerNo
e UnDeleteFeature RecNo, LayerNo

e UnSelectFeature RecNo, LayerNo
e ValidFeatureBnd RecNo , LayerNo

e ValidLayerBnd LayerNo

D) Editing One Feature (Record)

BH Streets.shp : Edit Feature

File Edit VB Script Help
RecMo 1
D 0
OBJECTID 2228
MAME e 15 505
CODE 10
SHAPE_LEMNG 326535.700121622
PARTS 1

Menu = Edit = Edit Feature Data

Edit Feature
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11) GIS Analysis and Selection Functions

A) Selection Menu

Find by Data (Query Builder)...

Mested Find by Data (Query Builder)...

Find & Data Transfer by Location (Cuery Builder)...

Cut & past Selected Features To

Copy & past Selected Features To

Delete Selected Features

Remove over write vertexes from all selected features

Combine interseced polylines in all selected features

Copy & Combine Selected Features into Parts in One New Feature

Copy & Separate Parts of Selected Features into Mew Features

Combine Parts of Selected Features into one Part

Close Edges of Selected Features

Invert Selection

Clear Selection

Zoom to Selected Features

Terrninate All Running Functicns

Ctrl+F

Ctrl+CQ

Ctrl+ U

Ctrl+C

Menu > Selection

Selection Menu

B) Nested Attribute Data Base Analysis and Selection

¢ Nested Find by Data

Layer

Landiarks.shp S

Creteria | 4] Features 0
Method  [New Selection S

Scale |0

il

|aGovR | |aosMz ~| |asHoR ~| |catip ~| |LNDMRKNM ~|
iyl Suoldandl oL 5 syl 33 ol alas ~ dyobanll ol 5101 A
T SLll sail 53 635 Sy Elosi
opdbiholl sl
yb ol Sl
wlve
<A Aw
< 3 | 3| |2 3 |
[s] [ [s] [ [s] [

Nested Selection Find By Data (Query Builder)

Menu > Selection = Nested Find By Data (Query Builder)

Select Layer Name

Select Criteria (All Feature or Inside Selected Features or Outside Selected Features)
Select Method (New Selection or Add to Selection or Clear from Selection)

Select Fields from the Fields Lists
Select Values
Select Map Scale for viewing result
Press Find to Start Searching the selected values
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C) Spatial Location Analysis and Selection

#4 Find and Data Transfer by Location — ot

Find in | Streetz.zhp Find

Cretenia |f—\|| Features

Lol Lef Lo

kethod | Mew Selection

Relation |Insi|:|e ar Intersect

Cretenia |f—\|| Features

Lol Lef Lo

Ta Layer |Streets.shp

v Apply Tolerance

Tolerance | gooonot Map Units [ 1 Meter = almost 0.00001 Decimal Degree |

.ﬂ.ppl_l,l D ata Tranzfer by Location for Checked Similar Figlds Nameg
Iv | Fram laper : Streetz.shp i
[ To laver: Streets.shp

o CIPsRTS
[ OBJECTID

[ MAME

[]copE

[ SHAPE_LENG

1 Mote:

Drata Trangfer iz a wery powerfull tool, So pleaze use it carefully. To undo Data Transfer,
Do ot Save Changes and Reload laper from lavers menu

Selection Find and Data Transfer By Location (Query Builder)

Menu = Selection = Find and Data Transfer By Location (Query Builder)

. Select Layer Name

. Select Criteria (All Feature or Inside Selected Features or Outside Selected Features)
) Select Method (New Selection or Add to Selection or Clear from Selection)

. Select Relation

. Select Relation to Layer

. Select Apply Tolerance or not

. Select Tolerance value

. Select Apply Data Transfer for Similar Fields Name or not

. Select Data Transfer Fields Names

. Press Find to Start Searching
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D) Attribute Data Base Analysis and Selection

#4 Find by Data — =
Layer | equpt_highway. zhp ﬂ Find
Creteria |.-i‘-.II Features ﬂ
M ethod | MHew Selection ﬂ

Fields Relation Unique values
bridleway s
MAME = construction
OMEWAY ¥ crossing
LaNES < cycleway
<>_= EMENJEncy_access poi
o foabway W
£ >

Idpdate Unique Y alues | |

28 Features have been updated Unique in Layer
equpt highway.zhp

[~ Match Caze Scale (200001

Copy unique values and pazt to multi files

Selection Find By Data (Query Builder)

Menu > Selection = Find By Data (Query Builder)

. Select Layer Name

. Select Criteria (All Feature or Inside Selected Features or Outside Selected Features)
) Select Method (New Selection or Add to Selection or Clear from Selection)

. Select Field from the Fields List

. Select Relation from the Relation List

. Press Update Unique Value to get all available values

. Select Value from the List or write it

. Select Match Case or not

. Select Map Scale for viewing result

. Press Find to Start Searching the selected value
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12) GIS Network Analysis Functions

A) Network Menu

Snap Vertexes To...

Divide PolyLines On...

Divide Polygons On...
Combine Parts Inte One Part...,

Build Shortest Path Met\Waorl...
Shortest Path MetWork Menu...
Clear Shortest Path

Network Menu

Menu > Network

B) Snap Vertexes to

iy Snap Vertexes To — pd

In Layer |Streets.shp Shap

Creteria |.-’-'-.II Features

LefLed e

Yerteres |\:"erte:-:es at Beqgin and End

Relation |Interseu:t zelected Vertewes or Lines In Layver

=

TolLaver Streetz.zhp

v Apply Tolerance

Tolerance ||:|_|:||:||:||:||:||:|-| tap Unites [ 1 Meter = almost 0.00007 Decimal Degres |

Mate :

Snap Yertexes iz a very powerfull tool, So pleaze uze it carefully. To undo Snap Yertexes,
Do not Save Changes and Reload laver fram layers meru

Network Snap Vertexes to

Menu = Network = Snap Vertexes to

. Select Layer Name

. Select Criteria (All Feature or Inside Selected Features or Outside Selected Features)
. Select Vertexes (All , OR (Begin & End) )

o Select Relation

. Select Relation to Layer

. Select Apply Tolerance or not

o Select Tolerance value
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C) Divide PolyLines On

PalyLine

Layers | Streetz.shp

- Divide

Creteria |AII Features

Ll Lo

=] [Fereee]

Relation |Intersect zelected Vertenes or Lines In Layer

ToLayer |Streets.shp

v Apply Talerance

Tolerance | 000000

Mote :

Lol

Map Unites [ 1 Meter = almost 0.00001 Decimal Degree |

Divide PolyLines is a very powerfull tool, 5o pleaze use it carefully. To undo Divide
PalyLines . Do not Save Changes and Reload laver from layers menu

Network Divide PolyLines on

Menu = Network = Divide PolyLines on

. Select Layer Name

. Select Criteria (All Feature or Inside Selected Features or Outside Selected Features)
. Select Vertexes (All , OR (Begin & End) )

. Select Relation

. Select Relation to Layer

. Select Apply Tolerance or not

. Select Tolerance value

D) Divide Polygons On

# Divide Polygons On

= X

Palygon

Layers | landmark. shp

ﬂ Divide

Creteria |AII Features

. [remeor

Felation 2 Segments Intersect selected features in Layer

To Layer |Streets.shp

v Apply Buffer
Buifer 0.001
Mote :

=

Map Unites [ 1 Meter = almaost 000001 Decimal Degree |

Divide Polygons is a very powerfull tool, So please use it carefully. To undo Divide
Palygonsz . Do not Save Changes and Reload layer from lavers menu

Network Divide PolyLines on

Menu = Network = Divide Polygons on

. Select Layer Name

. Select Criteria (All Feature or Inside Selected Features or Outside Selected Features)
. Select Vertexes (All, OR (Begin & End) )

. Select Relation

. Select Relation to Layer

. Select Apply Tolerance or not

. Select Tolerance value
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E) Network Build Shortest Path

-lﬁ Building Shortest Path MetWork — >
Polyline Sheets sh j Build
Layers reets. shp |

ERRRERERERRERENRRR RN RRRREENERRRENENN
¥ &pply Tolerance

Tolerance ||:|_|:||:||:||:||:||:|1 Map Unites [ 1 Meter = almost 000007 Decimal Degree |

8677 Interzection Points have been Built successiully in Streetz. zhp

Building Shortest Path Network

Menu = Network = Build Shortest Path Network

F) Layer Properties Network Option

Streets.shp : Single Layer Prorperties —

General | Color | Selection | Edit | Label | Fields NetWork | Hyper Link | 3D View | VB Script | Source |

x

Metwark Fare Calar _ Metwark. Draw Maode ID:up_l,l Pen ;I

Netwiork Fill Color _ Netwiork Draw Style | Salid -]
Use NetWork Factor | to be multiplied by

¥ the length of each feature in calculating Mefwiork Drawwidh ——F———————
the shortestpath) o rrmmmmmmnmann

Metwork Factor Field | [EE] Metwfork Fill Style ISDIid ;I

Ok | Cancel Apply |

Layer Properties Selection Option

Menu 2> Layers = Layer Properties > Selection

. Select Network Fore Color

. Select Network Fill Color

. Select Network Mode

. Select Network Style

. Select Network Width

. Select Network Factor ( to be used ) or Not
. Select Network Factor Field
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G) Network Build Shortest Path

[0 Smart GIS Map Editor & GPS Tracking 2017 : Cairo.arb -
File Edit w  Llayers  Selection  NetWork Suface  Tools  Help
e [+ |
D= N E || o8| S
I IMcitBuilding shp o
xStrEEIS.Shp o
[ railway.shp T |
CMiBridgs shp @l | ShortestPat.. — X
Clliandmark shp —_—
I building.shp <% Lo [oremst =]
O pavement.shp
CCJGOVBND.shp ™ Fields [ NAME S
CILIMARKZBND shp
EI;‘VLGEIND.Shp - T emibadd
a M‘:':-;hﬁ We 31 2202344089972
¥ meitZ.shp Y= 300B52267683735 F
[ ® NewPoint3.shp ﬂ
A Road.shp — - i
01 8 Paints.she ke >T<D— ;TZTJEEHAEE;S;%
O¥inewPolygont.shp ¥e  300GEEESERIAST To
[ = js test(2).shp [%0
CIMPumb.shp
O track.shp o Length 0
[ = hosp shp [ Flouts  412083201243369 02
It GE_138)New jpg En
+ PEAT Y ~
= e dlo 2oL
550§ e 2
k‘ |k 15 208
JEE | els 15 & 388
(el e s £
(el 0 s E5
= eblrall gl g LS
First Alrican Arabian Egyptian
GIS GPS Software Terminate
Map Unit = Degress 36 North >» Building Shertest Path Nebwark for Laper Strests.shp ~
LonarX = 31.179222741 5> Building Shertest Path Netwark for Laper Streets.shp
Lal oY = 30085952985 5> Building Shartes! Path Netwark for Laper Strests.shp
Scale  =1:27.700 5> et Shalest Path in Layer Sireets.shp
5> et Sharlest Path in Laper Slreets.shp
b v

Shortest Path Network

Menu = Network = Shortest Path Network

. Select Layer Name

. Select Field Name

. Press From Button

. Select on the map where to start
. Press To Button

. Select on the Map where to Go
. Press Run
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13) Surface Analysis Functions

A) Surface Menu

3D _View On / Off Toggle Ctrl+K

Build Tin Surface Analysis...
Contour Surface Analysis...
20 to 3D Surface Analysis...

Calculate Area and Volume...

Surface Menu

Menu = Surface

B) Building Tin Surface Analysis

[l Build Tin Surface(s)

Height Layer | GeshanUTM.shp | Build
Height Creteria IAH Features LJ
Height Field ~ |ELEVATION |

Tin Surface Layer |C: “Documents and Settings\ElshayalSmartGIS\

(¢ Build Surface by Delaunay Triangulation Method
(" Build Surface by Matrix Triangulation Method

615 Tin Surface(s) have been Built Successfully in Layer NewTinE5.shp

Note :
Building Tin Surface Analysis is a very powerfull tool, So please use it carefully.

Menu = Surface = Building Tin Surface(s) Analysis

Select Height Layer Name

Select Height Criteria (All Feature or Inside Selected Features or Outside Selected Features)
Select Height Field

Select Output Tin Surface Shape file name

Select Build Surface by Delaunay, if elevation points have unequal distances among them.
Select Build Surface by Matrix, if elevation points have equal distances among them.

Press Build
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4 Llshayal Smart Web On Line Software : NewProject1.arb

it Vew  Leyers  Selecion  MetWork  Sufece Tods  Help

NUE x Q4 ¥V EE | o ME0-¢Eme ¥
ok [

0 # MaagalahUTM shp ‘

u

O = MouflehUTM shp
O « NakhasyUTM shp
O~ GeshanContUTM s
O~ NazeemContUTM
O~ MeagalshContUT.
D MouflehContUTM. 5.
O/ NakhasyContUTM
[NewTin15 shp
[NewTin16 shp
[NewTin17.shp =
NewTin18 shp
[NewTin19 shp [N
NewContour1 75.shp
NewContourl 76.shp
NewContour! 77.shp
NewContour1 76.shp
NewContourl 79.shp
GeshanGEO shp -
NewTin1.shp £
[NewTin20 shp

e aaa

Map Unt = Meters 38 North 5> Noke: Saved * aib Projects by Version 4.1 01 laler . Can 1ol ba cpaned by eaiber version:
Lonorx = 632.243040593983 5> OpenPropct NewPropctl ab > Vssion: 458

Lator¥ = 1560533 612711750 »> Add Laver NewTin20.sho.

Scale =17333¢ 2> Save Proyect Newbropect] aib

T 615 Coursets doc [C.

C) Building Contours Surface(s) Analysis

[l Contour Surface(s) Analysis

Height Layer | GeshanlUTM.shp Ll Build |

Height Creteria |AII Features ;J
Height Field |ELEvaTION ~|
Contour Interval |1 Unit (5]
Base Contour IU Unit (5]

Contour Layer |C: “\Documents and SettingshElshayalSmartGISh

(¢ Build Surface by Delaunay Triangulation Method
¢ Build Surface by Matrix Triangulation Method

¢ Do not Build Surface, and Use Height Layer as Surface

68 Countours have been Built Successfully to Layer NewContour3.shp

MNote :
Contour Surface(s) Analysis is a very powerfull tool, So please use it carefully.

Building Contours Surface(s) Analysis

Menu 2> Surface = Building Contours Surface(s) Analysis

. Check Use Height Layer as Tin Surface or Not

. Select Height Layer Name

. Select Height Criteria (All Feature or Inside Selected Features or Outside Selected Features)
. Select Height Field

. Select Contour Interval

. Select Base Contour

. Select Output Contour Shape file name

. Select Build Surface by Delaunay, if elevation points have unequal distances among them.
. Select Build Surface by Matrix, if elevation points have equal distances among them.

. Select Do not build Surface, if Height layer is a Tin Surface

. Press Build
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] Elshayal Smart Web ine Software : NewProject1.arb

File Edit View Layers

==+

0

Selection

\4

NetiWork Suface  Toos  Help

=Rl AT V=

B GeshanUTM.shp
O = NazeemUTM.shp
O = MaagalahUTM.shp
O = MouflehUTM.shp
O * NakhasyUTM.shp
O GeshanContUTM s...
O NazeemContUTM....
O~ MaagalahContUT...
O~ MouflehContUTM s...
O NakhaayContUTM...
O INewTin15.shp

O JNewTin16.shp

O JNewTin17.shp

O INewTin18.shp

O INewTin19.shp

O NewContour 75.shp
O NewContour1 76.shp
O NewContour 77.shp
O NewContour! 78.shp
O NewContour! 79.shp
[ = GeshanGEO.shp
O INewTin1.shp

O JNewTin20.shp

& NewContour181.shp

EASRE

Map Unit = Meters 38 North
31

>> Add Layer NewTin20.shp

>> Save Project NewProject1.arb

>> ™ Add Layer has been canceled **
>> Add Layer NewContour181.shp

>> Save Project NewProjectl.arb

>

163

|l

) Elshayal Smart Web ine Software : NewProject1.arb

File Edit View Layers

iSSP (+)

A

Selection NetWork Surface Tools Help

Vi

fyl’lﬂ

=l

O = GeshanUTM.shp

O & NazeemUTM.shp
O = MaagalahUTM.shp
O = MouflehUTM.shp

® NakhaayUTM.shp
O GeshanContUTMs...
O~ NazeemContUTM....
O~ MaagalahContUT...
O MouflehContUTM.s...
O NakhaayContUTM...
O INewTin15.shp

O JNewTin16.shp

O JNewTin17.shp

O INewTin18.shp

O INewTin19.shp

O INewTin74.shp

[ NewContour285.shp

b7 e #]2]° ¢ 1@

EASRE

Map Unit = Meters 38 North

Lonor 86.102.132173338
Latory =1512,733.261234250
Scale 15618

>> Add Layer NewTin74.shp

>> Save Project NewProject].arb
>> Save Project NewProject].arb
>> Add Layer NewContowr285.shp
5> Save Project NewProject!.arb
>

>
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D) Converting 2D to 3D Surface Analysis

[l Convert 2D to 3D Surface(s) Analysis

Height Layer | GeshanUTM.shp _:J Convert
Height Creteria IAII Features __V_]
Height Field [ELEVATIDN LI
From 2D Layer IGeshanContUTM.shp _v_l
From 2D Creteria IAII Features _'_'J

To 3D Layer |C:'\Docurnents and Settings\ElshayalSmartGIS\

(¢ Build Surface by Delaunay Triangulation Method
(" Build Surface by Matrix Triangulation Method
¢~ Do not Build Surface, and Use Height Layer as Surface

68 Feature[s] have been converted ta 3D Successfully in Layer New2Dta3D43.shp

Nate :
Convert 2D to 3D Surface[s) Analysis is a very powerfull tool, So please use it carefully.

Converting 2D to 3D Surface Analysis

Menu = Surface = Converting 2D to 3D Surface Analysis

. Check Use Height Layer as Tin Surface or Not

. Select Height Layer Name

. Select Height Criteria (All Feature or Inside Selected Features or Outside Selected Features)
. Select Height Field

. Select Destination 2D GIS Shape File

. Select Criteria of the Destination 2D GIS Shape File

. Select Output 3D Shape file name

. Select Build Surface by Delaunay, if elevation points have unequal distances among them.
. Select Build Surface by Matrix, if elevation points have equal distances among them.

. Select Do not build Surface, if Height layer is a Tin Surface

. Press Convert
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E) Calculating Area and Volume of Surface(s)

Il Calculate Area and Volume of Surface(s)

Height Layer l GeshanUTM.shp l.l Calculate
Height Creteria [AII Features __'__I
Height Field ~ |ELEVATION |

Heihgt of Plane |0

o " Below Plane

Min Height = 1.953.895

Max Height = 1.994.675

2D Area = 106.187.028

3D Surface = 117.016.211
Yolume = 209.684.094.385

(¢ Build Surface by Delaunay Triangulation Method
" Build Surface by Matrix Triangulation Method

(" Do not Build Surface, and Use Height Layer as Surface

615 Area and Volume Surface(s] have been Calculated Successfully in Layer
GeshanUTHM.shp

Note :
1 Calculate &rea and Voume of Surface(s] is a very powerfull tool, So please use it carefully.

Calculate Area and Volume of Surface(s)

Menu 2> Surface = Calculate Area and VVolume of Surface(s)

. Check Use Height Layer as Tin Surface or Not

. Select Height Layer Name

. Select Height Criteria (All Feature or Inside Selected Features or Outside Selected Features)
. Select Height Field

. Select Height of the Calculating Plane

. Select above Plane or Below Plane

. Select Build Surface by Delaunay, if elevation points have unequal distances among them.

) Select Build Surface by Matrix, if elevation points have equal distances among them.

. Select Do not build Surface, if Height layer is a Tin Surface

o Press Calculate
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F) Downloading (ASTER and SRTM) NASA Geo DEM Height Files

Open your Internet browser and go to the following URL to Download ASTER Geo DEM
http://www.gdem.aster.ersdac.or.jp/search.jsp

Open your Internet browser and go to the following URL to Download SRTM height files
http://dds.cr.usgs.gov/srtm/version2_1/SRTM3/

G) Convert (ASTER and SRTM) NASA Geo DEM Height Files to Tin Shape File

[l Convert (ASTER & SRTM) DEM to Tin Shape file Eo®

DEM File |D:\World_M apsiHeighthASTERMASTGTM_N12EQ Browse

Lon Lat Interval No. of Points
| t I | Arc Seconds
v Clip Lon (dd) Lat (dd)
Left - Top |44 I13
Right - Bottom |45 l1 3

No. of Clip Points 12967201

Convert er

Note :
Convert [(ASTER & SRTM) DEM to Tin Shape file is Producing Tin of Elevation Paints

Advanced Spaceborme Thermal Emission and Reflection Radiometer [ASTER
http: /Awww. gdem. aster. ersdac. or.jp/search.jsp 1 Arc Seconds interval for World

Shuttle Radar Topography Mission [SRTH]

http:/ A jpl.nasa.gov/sitm/

http://dds.cr.usgs.gov/sitm/version2_1/SRTM1/ 1 Arc Second interval for USA
http: //dds. cr.usgs.gov/sitm/version2_1/SRTM3/ 3 Arc Seconds interval for World

Convert (ASTER & SRTM) DEM to Tin Shape file

Menu = Tools = Convert (ASTER & SRTM) DEM to Tin Shape file

Download Tiff DEM file from http://www.gdem.aster.ersdac.or.jp/search.jsp
Select and Enter Clip values of your Area Left Top point and Right Bottom point
Press Convert

Page 39 of 60


http://www.gdem.aster.ersdac.or.jp/search.jsp
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H) Convert ASTER NASA Geo DEM to Color value bmp File

E Elshayal Smart Web On Line Software : NewProject1.arb

File Edit View Layers Selection NetWork Surface Tools Help
O X O4 |V EE | | 2t SD-¢ B S #

[EI# N12E043_dem brp RNy

|4 N12E044_dem bmp %
|4 N12E045_dem bmp
|4 N13E043_dem bmp

N13E044_dem.bmp

N13E045_dem.bmp

M N13E046
N14

LonorX = 44275760134
LatorY = 14.060479768

Value = 3046

First Arabian GIS

:
Software
Map Unit = Degrees 38 North >> Save Project NewProject1.arb »
LonorX = 44.275760194 >> Save Project NewProject1.arb m
LatorY =14.060479768 >> Save Project NewProject1.arb
Scale =1:1,750,000 >> Save Project NewProject1.arb

>> Save Project NewProject1.arb

> ’v

1 N14E044_dem.bmp EN &) 03:06 o

Convert ASTER Geo DEM to Color VValue bmp file

Menu = Layers = Add Layer = Files of Type > TIFF = Open

Menu = Layers = Save Layer as = Change the File extension to > BMP_—> Save

o Open Aster Geo DEM Tiff file
o Save Layer as bmp file
. Press Identify at any point in image to get Elevation value
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1) Building Contours from ASTER NASA Geo DEM

J Elshayal Smart Web On Line Software : Nevd’ru)ecﬁ arh

O © AdenElevTIN_Geo..
.ﬁ NewContour29.shp

p— - —

EASRRYSE o
o] G e
Map Unit = Degrees 1 North >> Remove Layer NewContour. 23 shp s}
LonorX = 44860250534 >> Remove Laper NewTin16.shy
LatorY =12755681632 >> Add Layer N
Scale =1:7,994 >> Modify St ewContour29.shp Successfully
>> Save Proje . arb
> @

‘4 Start ~ME W 7o Elshayal Smart Web ... EN &) 0231 0

Menu = Surface = Building Contours Surface(s) Analysis
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14) GIS Tools Functions

A) Tools Menu
GPS Settings... Ctrl+G
Chat and GPS Tracking Mobiles and Devices... F11

Configure New Transverse Mercator Projection

Convert Shape Type and Grouping...

Convert Vector and Raster Layer Coordinates System...
Convert Coordinates System Calculator... Ctrl+)
Convert (ASTER & SRTM) DEM to Point Shape file...

Convert Leica GSI to Shape file...

Convert Sokkia Raw CRD to Shape file...

Convert Excel CSV to Shape file...

Convert Shape fileto Excel CSV...

Convert Autocad DXF to Shapefile...

Convert Shape fileto Autocad DXF...

Convert Google KML to Shape file...

Convert Shape files to HTML KML GIS Web Site Application...
Convert Shape files to HTML JS GIS Web Site Application...

Download from Google Earth...
Synchronize Google Earth with Geographic Lon-Lat Map

Menu = Tools

Tools Menu
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B) Chat and GPS Tracking Mobiles and Devices

% Chat and GPS Tracking Mobiles and Devices - >
ClentID  |Elshayal Clear Chat |
Connect Dismma:tl List Users |

Download Smart GIS Chat and GPS Tracking App from Google Play and Send pour Mobile
Location ta this Client |D in Smart GIS Map Editor [ Live View and Histary Save |

Live Paoint Layer lee j Reset Live Point Layer |

T Auto Live View Start Live Yiew | Stop Live Yiew |

History CSV File |

IT Auto History Save Start History Save | Stop History Save | Browse

ELSHAYAL to MO
Hello mo

List of Users
MO, TEST, ELSHAYAL

Connected

mao

it Send Text To Client ID

Chat and GPS Tracking Mobile and Devices

Menu = Tools = Chat and GPS Tracking Mobile and Devices
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C) Converting Vector and Raster Layers Coordinates System

Convert Vector and Raster Layer Coordinates Systern —

Layer Streetz.zhp j

Geographic Trangverse Mercator Projection
. B
Left - Bottom Zone  Right - Top Zone J J ['wiorld Geodstic System 1984 [WGS 84)
36 Morth 36 Morth
Zone |36 [1-60) Zone |36 [1-60])

Hemisphere © M 5 [~ A&l Lavers Hemisphere & M 7 5

Mote :

Cornveert Layer Coordinates System is a very powerfull tool, So pleaze use it carefully.
To undo Convert, Do not S ave Changes and Reload layer from layers menu

Converting Vector and Raster Layers Coordinates System

Menu = Tools = Converting Vector and Raster Layers Coordinates System

D) Converting Leica GSI files to GIS Shape Files

Convert Leica G5 to Shape file - X

CRD File |F:u:|:|r~.|mMH.gsi © Browse |

Shape Tupe |F'-:uint + Meazure + 2 J

Cormwert

EERRRERERNR RN RN ENERERNNREERENENEEEEEN
Corvert Leica GSI to Shape file

Mote :
Corvert Leica GS1 to Shape file iz a very powerfull tool, So please uze it carefully.

Converting Leica GSI file to Shape Files

Menu = Tools = Converting Leica GSI file to Shape File
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E) Converting Sokkia files to GIS Shape Files

Convert Sokkia Raw CRD to Shape file — >
CED File IF:HM}IHQ aliobia“"HA&RAS-1.crd Browse |
Shape Type IF'-::I_I,ILine + Meazure + 2 ﬂ

Cormert |

HERRRENRRNRRRENRNNRNEENEN
Convert Sokkia Faw CRD to Shape file

Mote
Corvert Sakkia Raw CRD ta Shape file iz a wery powerfull toal, So pleaze use it carefully.

Converting Sokkia file to Shape Files

Menu = Tools = Converting Sokkia file to Shape File

F) Converting Excel Csv files to GIS Shape Files

Convert Excel C5V to Shape file — -

5y File IE:"uMy"-.SmartGIS_F'resentatiu:un_final2"~3D:unversiu:un'~ Browse |

Shape Tvpe |{FE

CSY Yalue I
Cornert | Terminatel

Mote
Convert Excel C5Y to Shape file iz a veny powerfull tool, So please use it carefully.

Converting AutoCAD file to Shape Files

Menu = Tools = Converting Excel Csv file to Shape File
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G) Converting GIS Shape Files to Excel Csv files

Convert Shape Layer to Excel Csv File — -

From Layer |Street ﬂ Corvert
Creteria |.-’-'-.II Features ﬂ
Ewcel Cav File |E:"~M yhSmantGlS_Presentation_final2\3Conversi || Browse |

L5V Value -

Mote
Convert Shape to Excel Cav iz a very powerfull tool, So pleaze uze it carefully.

Converting Shape File to AutoCAD file

Menu = Tools = Converting Shape File to Excel Csv file

H) Converting AutoCAD files to GIS Shape Files

[l Convert Autocad DXF to Shape file

DXF File IC:\Documents and SettingshElshayalSmartGISiMy

Shape Type IPongon L]

Convert | |

315 Autocad DXF Features have been Converted Successfully to Shape File
MNate T
Convert Autocad DXF to Shape file is converting the following Entities
Arc, Block, Circle, Ellipse. Line. Point, Polyline, Solid, Text, Yertex.

Converting AutoCAD file to Shape Files

Menu = Tools = Converting AutoCAD file to Shape File
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1) Converting GIS Shape Files to AutoCAD files

[l Convert Shape Layer to Autocad Dxf File

From Layer I GeshanlUTM.shp LI Convert

Creteria IAI] Features ﬂ

v Apply Label settings in Layer Properties menu

...........................

Autocad Dxf File  |C:\Documents and SettingshElshayalSmartGISh Browse :

315 Shape Feature(s) have been Converted Successfully to Autocad Dxf File
GeshanUTM.shp

Note :
Convert Shape to Autocad Dxf is a very powerfull tool, So please use it carefully.

Converting Shape File to AutoCAD file

Menu = Tools = Converting Shape File to AutoCAD file

J) Converting Google KML to GIS Shape Files

Convert Google KML to Shape file —

Clo:

KL File |E:'\F‘ru:ugram Files [¥861\Smart J515 2019 streat kml Browse

Shape Type |F'|:-|_I,ILine j

Corvert | |

Mote :
Corvert Google ML to Shape file iz a ver powerfull tool, So please use it carefully.

Converting Google KMLto Shape Files

Menu = Tools = Convert Google KML to Shape File
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K) Converting GIS Shape Files to HTML KML Web GIS Site

Convert Shape files to HTML KML GIS Web Site — >

All visible Layer Web GIS ] One Layer Web GIS ]
Convwvert All vizible Shape files to HTML KML Web GIS Site App.

k.M Host LURL | Corvert
{* Corvert all " Convert HTHL " Corvert Al KML
[w PalyFaint Iv Table Data Thickness  Accuracy HTRL

lﬁ —p— Settings

[~ leon URL |https:Hfstnrage.gungleapis.cnma’mapapia’icuns.-’c Reset

t4ap Html File |E:'\M_I,I"~Smart G5 CompanytProjects Docurnent

Mote :

Corvert Shape files to HTML KRL GIS 'web Site Application iz a vem powerfull tool,
So pleaze uze it carefully, and Eindly be sure that voau are connected ta internet

Converting All visible Shape Files to Google KML App.

Convert Shape files to HTML KML GIS Web Site — >

All visible Layer Web GIS One Layer Web GIS ]
Convert Shape files to KML Web GIS Site Module

From Layer |Di$trict.shp ﬂ Corvert
Creteria |.-'1‘-.II Features j
[v PalyPaint [+ Table Data Thicknesz  Accuracy
(TSR
[~ lcon URL |https:.-".-"stu:urage.gu:n:ugleapis.u:-:um.-"mapapi.-"iu:u:uns.-"-: Reszet
Google KML File |E:'\.M_I,I'\Smart GIS Compary\Projects Document Br.;.wge
Mate :

Corvert Shape files ta HTML KML GIS YWeb Site Application iz a very powerfull taol,
So pleaze uze it carefully, and Kindly be sure that you are connected to internet

Converting Shape Files to Google KML file.

Menu = Tools = Converting Shape File to HTML KML Web GIS Site
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L) Converting GIS Shape Files to HTML JS Web GIS Sites

Convert Shape files to HTML J5 GIS Web Site — >

All visible LEYEI’ Web GIS l One Layer Web GIS
Convert All wisible Shape files to HTHML J5 Wehb GIS Site App.

J5Host URL | Convert
" Correert &l " Corveert HTHML " Corweert AllJS
[v PalyPaint [~ Label [v Table [~ Encivpted [ Encoded

Show Layer bebween Scale |1_ To E Thickness  Accuracy HTHL
0.4 — p———  Settingz
Show Label betwesn Scale F To E I_ R

[~ lcon URL ‘https:.-".-"stu:urage.gu:u:ugleapis.u:u:um.-"mapapi.»'iu:uns.-"c Reset

tap Heml File ‘E:'\M_I,I\Smart 15 ComparwhProjects Document

Mate :

Corvert Shape files to HTRL JS GIS ‘web Site Application iz a very powerfull toal, So
pleaze use it carefully, and Kindly be sure that you are connected to intemet

Converting All visible GIS Shape File to HTML GIS Web App.

Convert Shape files to HTML JS GIS Web Site — >

All visible Layer Web GIS One Layer Web GIS l

Convert Shape hles to Java Scrpt Web GIS Site Module

Corvert

From Layer

Creteria |.~'—‘«II Features ﬂ
[v PolyPoint [ Label [v Table [ Encrypted [~ Encoded

Show Layer between Scale |1— To E Thickness  Accuracy

0.4 —_——
Show Label between Scale F To E I_ RN

[~ lcon URL |https:.-".f'sh:urage.gu:u:ugleapis.cnm;’mapapi.-"iu:u:uns.-"c Feset
Layer JS File |E:'\M_I,I'\Smart GIS CompatyhProjects Document Browse
Mote

Corvert Shape fles to HTRML JS GIS ‘wWeb Site Application iz a very powerfull toal, So
pleaze uge it carefully, and Kindly be sure that you are connected to internet

Converting GIS Shape Files to HTML GIS Web Sites

Menu = Tools = Converting GIS Shape File to HTML JS Web GIS Sites
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M) Converting GIS Shape Files to Web GIS HTML. Settings

HTML Settings
‘“w'eb Settings

Selection Color -

Font |

BG Color ‘

Banner and Buttonz Setting

Titele |Srnart Africa Arab Egypt GIS GFS

Fore Calar ‘ Font

tap Settingz

N

Map Type |google.maps.MapT}lpeld.HD.&D b P j
Lng Center lm

LatCenter  [306368001316162 _ Retesh |

Zoom 12

Account and D ataB aze Settings

Directive |

SmartGIS
UszersList

SmartG15 for free Account
Acount

MNone for no D atabasze

Users List

Data Color

Tracking List

Usgerslist

Data Thicknes

Layers List

LapersList |D 5
Layer=T ables

Layers Tables

tenu Settings

I |Login i
W |Layers Wiew (o
Iw |Layers Search i
[~ |Tables Search ("
— D ata Callectar e
W |GPS Tracking ("
v Google Search e
™2 |Sh0rtest Path ("

width |150

Functions Settings

Height |180

Font | EG Calor ‘

[ Show Dynamic Lapers List

0

Show Static Layers List
Show Signlp Button
Show AutoSave GPS Option

q 7 7

Show Google Traffic
‘web " Mobile

2

Cancel |

Smart GIS
Convert Shape files to Web GIS

http://smartgis.us/ or

http://egygpstracking.com/

O comet )

Convert
XmlIHttpRequest s Shape Files
E and
-8 Rectified Images
v - to
HTML5
‘ ASP by
Server Procedures ’Y Smart GIS Map Editor
For more information
http://freesmartgis.blogspot.com/
Datsa QBLase ‘——) Google Map F—— Base Map Layers
Dynamic Static
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N) Smart Converting GIS Shape Files to Web GIS Flow Chart

Smart GIS System

Static Web GIS

Local o
-~
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0O) Smart GIS for Web & Mobile GIS Static functions

Displaying and Searching GIS Base Map Layers
Displaying GPS Location
Searching Google Map Data Base within Screen Map view

Calculating shortest path between two points

Smart GIS Static Web GIS
For more information / —_— ;

http://freesmartgis.blogspot.com/

- A Google Ma
G leS h = o

Satellite

‘ Shortest Path e Y 3. Terrain
i QT . 4. Hybrid

oy B ] S —

‘ GPS Tracking = e e e e

Layers Search ———> T Base Map Layers
Governorates
Districts
Villages
Facilities
Others

Layers Reports ———>

USRS R

Layers Analysis ————————>|

30f 50
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P) Smart GIS for Web & Mobile GIS Dynamic functions

e Register new users

e Login users (with different permission levels)

e Searching for nearest facilities in database (Spatial search)

e Searching facilities by information data (Attribute search)

e Identify facilities information by click

e Adding and modifying attribute tabular data for each facility point

e Reporting and calculating the number of facilities in specific buffer

e Reporting and calculating the number of facilities according specific attribute data

e Build graph chart to view total number of any specific attribute data

Smart GIS Dynamic Web GIS

c
. . = EE= o T Register & Log in
For more information = Y & 1. Admin
http://freesmartgis.blogspot.com/ “ER L _ g User

Visitors

X e i (—( Data Collector ‘

‘ Facilities Reports

A= I Facilities DB
% = A 1.  Number of Facilities
- e 2. Type of Facilities
' . L P T T T R | 3. Availability of
o facilities

‘ Facilities Analysis

‘ Services Reports

Services DB

1. Number of Services

2. Type of Services

3. Availability of
Services

L]

‘ Services Analysis

4 of 50
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Q) Converted Free Web GIS Examples

World

https://storage.googleapis.com/smartgis/World/index.html

Africa

https://storage.googleapis.com/smartgis/Eqypt/index.html

https://storage.googleapis.com/smartgis/Ethiopia/index.html

https://storage.googleapis.com/smartgis/Nigeria/index.html

https://storage.googleapis.com/smartgis/Rwanda/index.html

Asia

https://storage.googleapis.com/smartgis/Cambodia/index.html

https://storage.googleapis.com/smartgis/Malaysia/index.html

https://storage.googleapis.com/smartgis/Qatar/index.html

https://storage.googleapis.com/mapapi/Saudi/index.html

https://storage.googleapis.com/smartgis/UAE/index.html

https://storage.googleapis.com/smartgis/Yemen/index.html

Europe

https://storage.googleapis.com/smartgis/France/index.html

https://storage.googleapis.com/smartgis/Italy/index.html

https://storage.googleapis.com/smartgis/Spain/index.html

North America

https://storage.googleapis.com/smartgis/sandiego/index.html

Another Example

https://storage.googleapis.com/mapapi/BlogSpot/index.html
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https://storage.googleapis.com/smartgis/Egypt/index.html
https://storage.googleapis.com/smartgis/Ethiopia/index.html
https://storage.googleapis.com/smartgis/Nigeria/index.html
https://storage.googleapis.com/smartgis/Rwanda/index.html
https://storage.googleapis.com/smartgis/Cambodia/index.html
https://storage.googleapis.com/smartgis/Malaysia/index.html
https://storage.googleapis.com/smartgis/Qatar/index.html
https://storage.googleapis.com/mapapi/Saudi/index.html
https://storage.googleapis.com/smartgis/UAE/index.html
https://storage.googleapis.com/smartgis/Yemen/index.html
https://storage.googleapis.com/smartgis/France/index.html
https://storage.googleapis.com/smartgis/Italy/index.html
https://storage.googleapis.com/smartgis/Spain/index.html
https://storage.googleapis.com/smartgis/sandiego/index.html
https://storage.googleapis.com/mapapi/BlogSpot/index.html

15) Downloading Google Earth Maps Functions

A) Google Earth Seetings

=R Google Farth g@@

File Edit View Tools Add Help

-GOogle

.
#  mage©2010/GeoEye

Imagery Date: Jul 24, 2009 lat 29.982488 lon 31.154367° elev. Om TEyealt RETINREY
‘4 Start ~E & Images & DOC T GI5Co., | [ Untitled... | malElshaya.,. | melElshaya,. i AlLIP... ] Roads.... N Downlo... Google...  EN @84 5

) Open Google Earth 4.3 or Later Versions ( It must be installed in your Computer )
o Inside Google Earth, do the following Settings

o Tools > Options : Turn Off Terrain

o Be Sure that North Arrow is completely very up by

o View > Show Navigation = Always
o Press Double Click on North
. Be Sure that Google Earth is very Flat by:
o Pressing keyboard Shift and keyboard Up Arrow.
o Pressing Keyboard Ctrl and keyboard down arrow
. Close Google Earth
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B) Download Google Earth Maps

Q{Download from Google Earth 4.3 or later

Logout Google Earth Lon |31.1543673723197 Up |
Goto Lat |29.9824877540548 Left | Right l
Refresh Coords ggg: 30 m Down |
[ Shift Maps for Google Version 5 |0.9545 4 Import Rectified Image |
v Hide Google Layers

Note - Google Earth is Connected

Download from Google is producing Rectified and Geo-Refrenced JPG Images

Show Download Help Show Google Settings Help

Download From Google Earth

Menu = Tools = Download Form Google Earth

o In GIS Software

. Press Login Google Earth 4.3 or Later Versions ( It must be installed in your Computer )
o Press Refresh Cords Button in GIS Software to get Google Earth Position

o Enter Your Lon & Lat Cords' and Scale Zoom

. Press Go to

o Press Import Rectified Image (Will Capture B&W Google Earth Map)

. In Google Earth Software

. Press Save Image to overwrite the B&W Image File

o In GIS Software

. Reload Layer from Layers Menu to get colored rectified Image.

. Use Up, Down, Right, Left Buttons to navigate

. Press "Go to Layer in Google" in Layers Menu (to find layer area in Google)
. Press "Go to Feature in Google™ in Edit Manu (to find your area in Google)

. Check Shift Maps, If your Google version is 5 or later
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C) Save Map as rectified Images

i Save Images Setup
-Paper Size ~Orientatior
' Portrait
" Landscape

-Paper Dimensions Scale

Width = 794 Pizels

Height = 1123 Pixels |3°595
~Custon

i ) v Edges Coordinates

Width 794 Pizels

Height (1123 Pixels 0K | ) |
MNote :

Save Images is producing Rectified and Geo-Refrenced Bitmap Images

Save Images Setup

Menu = Files > Save Images

This Function will produce

o Bit map image BMP with Edges Coordinates
o BPW World File format for BMP Image
o JGW World file format For JPG image
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D) Synchronize Google Earth with Lon Lat Geographic maps

E Elshayal Smart Web On Line Software : NewProjecté.arb

File Edit View Layers Selection NetWork Surface Tools Help

NOE %[O 4 ¥ = || o 98 &d-¢ B B S 2|

O NewPolygonMZ1 s..
CIM NewTinl.shp

- o L g 5 .
4 oy wi Imagel©)2010 GeoEye"
(e -
Map Unit = Degrees 1 North >> **Google Earth is not connected , Please Login Google Earth -> Tools Menu »
LonorX = 31153130333 55 Add Layer GE_1.jpg
LatorY = 29383763323 55 Zoom to Layer GE_1.jpg
Scale =1:1,000 >> **Tao Synchronize Google Earth: Please be sure Google Earth is not maximized and is not Full Screen

>> Remove Layer GE_1.jpg
>

T GIS Course07.doc [C... R Google Earth EN @& B4 1156 0

Synchronize Google Earth with Lon Lat Geographic Maps

Menu = Tools = Synchronize Google Earth with Lon Lat Geographic Maps

Settings

. Open Google Earth 4.3 or Later Versions ( It must be installed in your Computer )
. Inside Google Earth, do the following Settings
. Tools > Options : Turn Off Terrain
. Be Sure that North Arrow is completely very up by
o View - Show Navigation = Always
o Press Double Click on North
) Be Sure that Google Earth is very Flat by:
o Pressing keyboard Shift and keyboard Up Arrow.
o Pressing Keyboard Ctrl and keyboard down arrow

. Close Google Earth

. Open GIS Software

. Set Map Projection to Decimal Degree

. Be Sure Google Earth Software is NOT maximized and is NOT Full Screen

Page 58 of 60



16) Results & Conclusion

As can be seen from the preceding discussion, developing from scratch GIS software is very
expensive, very exhausting, and academic research centers and institutes must support and
endorse those efforts.
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